
Twinkler – User Guide

The “Twinkler” is a small electronic device for lighting effects. The device embeds 
an RGB LED, a controller, a voltage regulator and provisions for mounting a light 
pipe. A Twinkler can run a schedule (with light and colour changes, including fad-
ing, blinking and “twinkling” effects) by itself, or accept commands transmitted 
over a serial line. An arbitrary number of Twinklers can be daisy-chained to form a 
long LED line, in which each LED can be individually controlled. Power runs over 
the same cable as the serial communication line.

The on-board controller on the Twinkler manages the dimming, fading, blinking 
and “twinkling” of the LED, off-loading this task from the PC or the device that 
drives the Twinkler(s). As a result, the Twinkler boards can be updated relatively 
quickly with low overhead for the PC or controller that performs this updating.

The daisy chain of Twinklers forms a serial bus that carries commands and data. 
The input and output lines of each Twinkler are filtered to reduce EMC emission 
and increase EMC immunity. Each Twinkler also has its own voltage regulator, to 
annul the effects of voltage drop over a long bus and to reduce EMC on the power 
lines. Due to the current capacity of common ribbon cable, it is advised to mount 
a power repeater after every 75 Twinklers in a chain.
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Preliminary
Anti-static handling precautions
Please observe anti-static handling precautions when handling the device, as it contains 
components that are sensitive to static discharges.

Legal disclaimer
ITB CompuPhase shall not be liable for the incidental or consequential losses or damage 
to tangible property, injury or death of a person in connection with the use of this device.
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Twinkler hardware
A Twinkler board has two sockets for 6-wire ribbon cable with Micro-MaTch con-
nectors. The Twinkler receives both power and data (serial communication) on the 
connector marked “IN”; it forwards power and data on the connector marked “OUT”.

Twinkler “component side” (the LED is at the reverse side)

A Twinkler may optionally be equipped with a light pipe. Several light pipes are 
available: solid and flexible and from 2 to 5 mm diameter. See the photograph on 
page 1 for an example of Twinklers with a 5 mm solid straight light pipe).

Connecting a Twinkler to a PC
To connect a Twinkler to a controller device, such as a PC, an interface board is 
needed. Two interface boards are available: one that connects to an USB port of a 
PC, and an RS232 port (see Accessories on page 12).

The Twinkler USB interface

The Micro-MaTch connector of the interface (marked “OUTPUT”) must be attached 
to the “IN” connector on the Twinkler (see the above figure and the figure on the 
next page). The second Micro-MaTch connector on the interface board, labelled 
“LOOP”  or  “LOOPBACK”,  is  optionally  connected —see the section “Daisy-chaining 
Twinklers” on page 4 for details.

Both interface boards also supply power to the Twinkler. A suitable power supply 
is required (7 V to 9 V DC).

The  USB  interface  has  an  additional  connector  for  general  purpose  I/O.  For 
example, push-button switches can be connected to the interface. With the pro-
grammers toolkit, you can then use these switch inputs to create an interactive 
presentation. Refer to the data sheet of the USB interface for details.
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Daisy-chaining Twinklers
Each Twinkler board has two connectors: one is input and the other is output. 
Both  connectors  are  “Micro-MaTch”  connectors  for  6-wire  ribbon  cable  (see 
Accessories on page 12). The connectors have a polarity notch for proper orienta-
tion.  Daisy-chaining boards is  a simple matter  of  connecting the “OUT”  of one 
board to the “IN” of the next board.

Optionally, you may also connect the “OUT” of the last Twinkler board to the “LOOP” 
(or “LOOPBACK”) connector of the controller interface, thus creating a loop. A loop 
allows some basic diagnostics; when there is no loop, the controller device cannot 
read back any data from the daisy-chain. Note that not all controller devices or 
interface boards have a “LOOP” connector.

The theoretical maximum number of Twinklers in a chain is 16,255. This limit is 
imposed by the addressing mechanism in the serial communication protocol.

Adding power repeaters
The maximum current consumption of each Twinkler board is specified at a max-
imum 45 mA. The ribbon cables and the connectors are specified at a maximum 
of 3.5 A at  20 °C. This means that a power line in a daisy-chain should be no 
longer than approximately 75 Twinklers. When chaining more than 75 Twinklers, 
a power repeater should be placed in the chain. A power repeater is a passive 
board with Micro-MaTch connectors for input and output, and a DC-power con-
nector.
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Power repeater board

The power repeater boards (see Accessories on page 12) have a diode to protect 
against polarity inversion. Because of this diode, the minimal voltage of the power 
supply is 6 V. The recommended voltage is in the range 7 V to 9 V DC.

To insert a power repeater in a chain, connect the “OUT” of the last Twinkler of a 
segment to the “INPUT” of the repeater, and the “OUTPUT” of the repeater to the “IN” 
of the first Twinkler of the next segment. Also connect a power supply to the DC-
power connector.

The  “RESET”  pins  on  the  power  repeater  are  usually  left  unconnected.  For  an 
example of how these pins can be used to run a simple show, see “Storing a scen-
ario on the Twinklers” on page 9.

Note the relative position of the “INPUT” and “OUTPUT” connectors, as compared to 
the “IN” and “OUT” connectors on a Twinkler board.
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Twinkler software
Obtaining the software
Download the software and associated documentation from the web site:

http://www.compuphase.com/twinkler/

The software for the Twinkler exists for Microsoft Windows and for Linux.

Installing and configuring the software
The Twinkler software is distributed as a “setup” program for Microsoft Windows 
and a self-installing “autopackage” for Linux. In both cases, run the program to 
install the software.

The Twinkler configuration utility (Microsoft Windows version)

After installation, run the program, and adjust the settings (menu “Control”, then 
“Settings”). You should select a COM port for the program to use. For Microsoft 
Windows, the ports are called “COM1”, “COM2”, etc. In Linux, standard serial ports 
are  called  “ttyS0”,  “ttyS1”,  etc.  and  USB  virtual  ports  are  called  “ttyUSB0”, 
“ttyUSB1”, etc.

If you have a USB interface board (see page 3) and if the drivers for that USB inter-
face are installed, the settings dialog also lists a port with the name “Twinkler 
USB”. You may select this port for enhanced functionality, specifically the support 
of external switch inputs. See the section “Configuration of auxiliary inputs” on 
page 9 for details. When running in Linux, you may need to run with “root” priv-
ileges to access the “Twinkler USB” port.

The Baud rate to use depends on the maximum length of the cables between 
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Twinkler boards and the background radiation level (EMC) in the area. For short 
cables  (below 1 metre),  the high Baud rate  setting of  115,200 bps  is  almost 
always fine.

Creating a scene (set the colours of all Twinklers in a chain)
A scene defines a state (colour) for all Twinklers in a chain. Each scene consists of 
a set  of  ranges.  A range can be a  single Twinkler,  or  a  series of consecutive 
Twinklers. The range is specified with the index numbers of the first and the last 
Twinkler that is part of it. The very first Twinkler in a daisy chain is number 1, all 
other Twinklers are numbered sequentially from that.

For a range, enter the first and last index numbers in de fields below the columns 
“From” and “To”, then click on the “Colour” field to choose a colour. If a range is 
for a single Twinkler, the “To” field may be left empty. If you do not plan using 
ranges, you can hide the “To” column, see the “Edit” menu.

When selecting a colour, please note that the Twinkler has a limited range for its 
red, green and blue channels. The configuration software therefore rounds the 
colours that you select to the nearest approximation that the Twinkler hardware 
can display. Therefore, the software may show a (slightly) different colour than 
the one that you chose.

The colour selection dialog allows you to insert the selected colour into a custom 
palette. The custom palette is saved in the file with the scenes. Therefore, the cus-
tom palette may help you to use a consistent set of colours over several ranges, 
or over several scenes.

Optionally, you may also enter a description for the range. This text is only for 
your own reference; the program does not use the description in any way.

When right-clicking with the mouse on a row, a pop-up menu appears, from which 
you can choose to insert or to delete a row; or to move a row up and down.

The fields for the hold time are relevant only when there are multiple scenes in a 
configuration file (a “scenario”) —see “Creating a scenario” on page 8.

Effects
There are two effects: fading and blinking. The fade setting is applies to all Twink-
lers in a chain —but it may change per scene; there is a field for the fade setting 
below the grid with colour definitions (just above the status bar). The blink field 
can be set  for each range of Twinklers.  Thus, in a chain, you can have some 
Twinklers blinking and some Twinklers non-blinking.

The fade speed is given as a value between 0 and 215. Values between 1 and 10 
are fairly fast fades (0 = "no fade"). Values above 20 are fairly slow fades. The dur-
ation of a fade depends on the original and the target colours.

The fade duration is taken into account when blinking is active (see below), and 
when moving to a next scene (see “Running the scenario” on page 8). Note that 
the with slow fades and quick blinks or scene switches, the fade may not have fin-
ished before it starts a next fade.
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The “Blink” column for each row in the grid must be a value between 0 and 14. 
Values between 1 and 10 indicate blinking, at various speeds; values between 11 
and 14 are for “twinkling” at several speeds; and a value of 0 is solid on (no blink-
ing, no twinkling).

For blinking (a value between 1 and 10), the value is the number of on-off cycles 
in a 3 second period. So if you fill in “2” in the “Blink” column, the Twinkler will  
blink twice per 3 seconds, or once every 1.5 second.

Twinkling is similar to blinking, but with a random interval. The value gives the 
average speed of the random blinks, with the value 11 being a slow twinkle effect  
and 14 a fast twinkle effect. In practice, twinkle effects work best in combination 
with a quick fade (e.g. set the fade to 1 or 2 when doing twinkling).

Loading and saving scenes
The application automatically saves configuration files when they are modified. 
On start-up, it loads the file that was active at the most recent usage of the applic-
ation. To explicitly save a configuration file, to create a new configuration, or to 
load an existing configuration, use the “File” menu.

If the Twinkler chain is not connected to the PC on which you run the configura-
tion application, you often need to save a configuration twice: first on the local PC 
(as the base configuration file for further editing at a later date), and second on an 
USB  memory stick  or  a  memory card,  which  you then insert  in  the controller 
device. For example, you may use a solid-state mini PC without display to drive 
the Twinkler chain and do the editing on a laptop.

For this situation, the application has the menu option “Save copy as…” (in the File 
menu). This command allows you to save the configuration in a different location, 
but it does not alter the name and location of the base file.

Creating a scenario (sequence of scenes)
From the “Edit” menu, you can select the option to add another scene to the con-
figuration. When there are multiple scenes in a scenario, there should be a “hold 
time” for every scene. The hold time is the time that the scene stays up, before 
moving to the next scene. You may optionally also specify a fade speed.

Running the scenario
Before running a scenario, make sure that the Twinkler chain is connected to the 
correct  (virtual) RS232 port  (or  adjust  the settings of the configuration utility). 
Then, select from the menu “Control” the option “Run” (or click on the toolbar but-
ton labelled “Run”).

When a scenario has multiple scenes, the Twinklers will start with the active scene 
and move sequentially over  the other  scenes,  taking the hold times and fade 
speeds into account. After the last  scene, the Twinklers loop back to the first 
scene.
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If the hold time for a scene is zero, the scene will not move forward to the next 
scene automatically. If the last scene has a hold time of zero, the scenario stops, 
without looping back. You can define “inputs” (usually switches) to move forward 
or backward, if the hold time for a scene is zero.

To run a scenario on start-up, run the Twinkler utility with the name of the scen-
ario file as its (command-line) parameter. If a parameter is present, the utility will 
load it and automatically start playing it. Alternatively, store the scenario on the 
Twinklers, so that the scenario runs without requiring a computer. See the section 
“Storing a scenario on the Twinklers” on page 9 for details.

Configuration of auxiliary inputs
Some interface boards (with which you connect a chain of Twinklers to a PC) have 
extra pins for external switches. For example, the USB interface has a connector 
for up to four external switches. To use the auxiliary inputs, you need to use the 
appropriate driver (usually “Twinkler USB”); see the section “Installing and config-
uring the software” on page 6 for details.

For each of the inputs, you can define one of these actions:

• a standard action: restart scenario, go to the next scene, go to the previous 
scene or pause/resume the timer;

• the name of a scene to jump to

Note that jumping to the first scene and restarting a scenario are the same action.

The default  configuration is the set  of standard actions:  input 1 is defined as 
“restart scenario”, input 2 as “next scene”, etc. To change the configuration, select 
the menu “Edit” and then the option “Input configuration”. The input configuration 
is specific for a scenario and it is stored inside the scenario file.

Storing a scenario on the Twinklers
A daisy-chain of Twinklers can run a simple (non-interactive) scenario autonom-
ously. A scenario, as created in the configuration utility, can be transmitted to the 
Twinklers'  ROM.  After  transmission,  the  Twinkler  chain  will  run  the  scenario, 
without requiring connection to a computer or controller.

The maximum number of scenes that can be stored on a Twinkler chain is 64.

To  transmit  a  scenario,  select  the  menu “Control”,  and  then  option  “Program 
Twinklers”. Please wait until the utility notifies you that it has finished program-
ming the Twinklers. During programming, the LEDs of the Twinklers will flicker.

After power-up or reset, the Twinkler chain starts with the first scene and moves 
sequentially through the scenes, taking the hold times into account. The Twink-
lers may loop from the last scene to the first, depending on whether the hold time 
of the last scene is zero. If the hold time is zero, the scenario will only restart 
after  the chain is reset. The power repeater boards (see page  4) have a reset 
jumper block for this purpose. Shorting the two pins of this block for 0.1 second 
(or longer) causes the Twinkler chain to reset and the scenario to run from the 
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first scene.

Additional documentation
A guide for programmers, “Programming the Twinklers”, describes the protocol 
to drive a chain of Twinklers from a PC. The document contains examples in vari -
ous programming languages and for several platforms. The function libraries are 
also included as source code.

To obtain additional documentation, software and application notes, please see 
the web site:

http://www.compuphase.com/twinkler/
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Specifications
Absolute maximum ratings
Operating voltage (Vcc). . . -0.3 V to +10 V
ESD rating, HBM.............. 2 kV
Input voltage on I/O pins. -0.3 V to 5.3 V

Electrical
Operating voltage (Vcc). . . 6 V to 9 V DC.
Current consumption...... < 2 mA when the LED is off; 45 mA max. when the LED 

is full on (white).
EMC / ESD....................... all I/O lines and pins are EMC-filtered and ESD-protec-

ted.
Serial line........................ 5 V TTL logic levels, 9600 and 57600 bps.
Connectors...................... Micro-MaTch, 6-pin.

LED
Refresh frequency (PWM). 72 Hz.
Luminous intensity.......... typical:  230  mcd  (red),  480  mcd  (green),  110  mcd 

(blue).
Dominant wave length..... 626 nm (red), 525 nm (green), 470 nm (blue).
Viewing angle.................. 120°.

Operating conditions
Operating temperature.... -30 °C to +85 °C.
Humidity......................... 5% to 90% non-condensing.
Vibration......................... solid-state device, no moving parts.

Mechanical
Board size....................... 18.5 mm x 17.8 mm.
Weight............................. approximately 0.004 kg (without light pipe)
Mounting........................ two holes, Ø2.4 mm; when using a light pipe, the light 

pipe is fixed in these holes.

Conformity
European Community...... EN 55022 (emission), EN 55024 (immunity).
U.S.A............................... t.b.a.
RoHS............................... Compliant with EU Directive 2002/95/EC.
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Daisy-chain cables
Type................................ 6-wire ribbon cable, 1.27 mm pitch, AWG28
Current capacity.............. 3.5 A for Vcc and ground wires at an ambient temperat-

ure of 20 °C.

Connector pin-out
Input and Output............. pin 1 & 2 Vcc

pin 3 reserved (leave unconnected)
pin 4 serial data
pin 5 & 6 GND

Pin 1 is the pin that is nearest to the polarity notch of 
the Micro-MaTch connector.

Accessories
Light pipe........................ Choice  of  5 mm  straight  light  pipe,  length  45 mm; 

3 mm straight light pipe, length 45 mm; 2 mm flexible 
light pipe with 4.2 mm lens, length 80 mm or 150 mm.

USB interface................... Board  to  interface  a  Twinkler  chain  to  a  controller 
device with an USB output. The board has an USB con-
nector,  a DC-power connector,  two Micro-MaTch con-
nectors and an I/O connector.

RS232 interface............... Board  to  interface  a  Twinkler  chain  to  a  controller 
device with RS232 output. The board has a 9-pin D-sub 
connector,  a DC-power connector  and a Micro-MaTch 
connector.

Power distribution board. Passive board with two Micro-MaTch connectors and a 
DC power connector.

Power supply................... Switching power supply, 7.5 V, 4 A (Mean Well P40A), 
with 2.1×5.5 DC plug; input voltage 90V~264 V AC.
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